
 
Quick Start Tutorial 

Presentation Tutorial for a Quick Start Hands-
on Session: Creating a simple Project using 
PWM and Count Apps. 
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Scope of the Project for this Hands-on Tutorial 

 Changing the brightness of 
an LED with the PWM App 
PWMSP001 

 The interrupt on timer 
period match changes 
the brightness of the 
LED by changing the 
duty cycle of the PWM 

 Counting of the PWM 
pulses with the count App 
CNT001 

 The interrupt on the 
count match toggles 
between increasing and 
decreasing of brightness 

 

 

 

 
Page 2 2014-03-18 Copyright © Infineon Technologies AG 2014. All rights reserved. 

Sequence Diagram 
 



Used HW Setup for this Hands-on Tutorial 

USB connection 
form the PC, the 
board is also 
powered via USB. 

XMC4500 CPU 
board. 

The LED of the CPU board is 
used to demo the functionality 
of  the PWM and Count App. 

More details about tools and kits and how 
to buy can be found at: 
www.infineon.com/xmc-dev 
 

J-Link on board 
debugger (OBD). 

It is also possible to use a different XMC kit 
(e.g. Relax kit or XMC4400/XMC4200 kits or 
one of the XMC1000 kits). In this case a 
different target MCU (page 6) has to be 
selected and the LED might be on a different 
port which has then be considered in the 
manual pin assignment (page 29). 
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DAVE™  Development Platform 

 Please be sure that you always use the 
latest version of DAVE  
This tutorial was created with DAVE  
v3.1.10 

 Version information can be found in: 
-> Help ->About DAVE 3  

 

 We recommend to regularly check for 
plug-in updates and install new updates: 
press ->Help ->Check for Updates 

 

Before starting this tutorial please download and install DAVE. 
The download package contains detailed installation instructions. 
Video tutorials about installations can be found here. 
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http://www.infineon.com/cms/en/product/promopages/aim-mc/DAVE_3_Download.html
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http://www.infineon.com/cms/en/product/promopages/aim-mc/DAVE_3_Support_Portal/Video_tutorial.html


Steps to Accomplish this Tutorial 

 Test of your DAVE installation with an 
EasyStart project 

 Download DAVE Apps from the web 

 Create a DAVE CE project 

 Select required DAVE Apps 

 Configuration of DAVE Apps 

 Signal Connection 

 Manual Pin Assignment 

 Resource Solving 

 Code Generation 

 Coding 
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Create an EasyStart Project to check the 
HW Setup 

Create an EasyStart Project and check that the HW and the Debugger setup is OK 
The EasyStart project is a blinky project that can be used to get easily a first program running. 

Press: >File >New >DAVE Project 
1 

2 
3 

4 

5 

Enter project name: 
MyEasyStart 
 
 
Select Project Type:  
Easy Start Project 
 
 
 
 
Press: Next 

6 

7 

Select the target MCU 
Press: Finish 

8 
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The EasyStart Project is now added in the 
Workspace 

The project contains 
the : 
• Startup files 
• NewLib stubs 
• EasyMain.c and 
GPIO.h 

• Linker script file 
 
The new created 
project is the active 
project, most actions 
are applied to the 
active projects (build, 
debug, properties,..). 
The active project can 
be changed with right 
mouse click on the 
project. 

The EasyMain.c can be 
regarded as template 
for the first simple 
programming trials with 
the XMC4500 without 
using DAVE™ Apps. 
 
Default functionality: 
LED toggling on Port 
3.9, toggle frequency 
based on the analog 
value on port 1.14. 
 

By pressing the “Build Active Project” or “ Rebuild Active Project” 
Button the project can be build. 

1 

1 
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Starting / Launching the Debugger 

After successfully building of the project the debugger can be started (ensure that the 
board is connected and correctly and the J-Link debugger device is ready to use). 
 

1 Click on the Debug button to start the debugger 

The first time when the debugger is launched for 
a project the debug configuration view show up: 
Double click on TASKING C/C++ Debugger 
creates a new debug configuration. 
Alternatively  a double click on IFX GDB 
Debugging creates a debug configuration  for the 
GDB. 

2 

The default settings support this HW setup, in 
case a different HW setup is used it might be 
necessary to adjusted the settings. 
 
Press Debug to start the debugger. 

3 

When pressing the Debug button the second time the debugger starts automatically with 
the last used debug configuration. 

1 

2 

3 
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How to operate the TASKING debugger 

After the debugger has loaded the image into the Flash the Eclipse perspective is changed 
to the TASKING Debugger perspective.  

Debug view for 
program control: 
•Resume (start) 
•Singe stepping 
•Suspend 
•Reset 
•Terminate 
•etc 

Editor window with 
source code 

Disassembly 
view 

Memory view 

Register view 
of the  SFRs 
for the XMC 

Variable View  
Breakpoint view 

Views can be freely and flexible arranged, new views can be added: >Window >Show View 
 
When using the GDB then the default CDT debug perspective will be opened that provides a similar 
functionality as the TASKING debugger. 

1 

1 When pressing Resume, the program starts and the LED on the Hexagon CPU board should blink. 
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Download of DAVE™ Apps from the Web 

1 

2 

3 

4 

Press: >Help >Install Apps/Example Library. 

Select: DAVE Apps Library Manager. 

In case this option is not visible click on 
Library Update Site and  activate  both links 
In case of connection failures see next page. 

Select: Library_DAVEApps and 
Library_DAVEDeviceDescription 
(Release is continuously updated) 

Filters may be checked. 

Press: Next  
and follow further instructions. 

1 2 

3 

4 

4a 

5 

Now the DAVE Apps and Device Descriptions 
are downloaded to your local library store 
located at: ..\<user>\Infineon\D3LibraryStore 

When using the DAVE installer then a complete set of DAVE Apps libraries has been already 
installed. In spite we recommend to do the following steps to ensure that the most current 
versions of DAVE Apps libraries are installed. 

4a 

5 
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Alternative Network Connections Settings  / 
Manual Download of DAVE™ Apps 

Depending on security / firewall settings of the LAN, connection to the web may fail. 
In this case changing of the Eclipse Network settings may help. 
 
 1 

2 

3 

4 

Press:  
>General >Network 
Connections. 
 
 Select : Direct (when outside of 

a secured company LAN) 
Or 
Select Native (when inside of a 
secured company LAN). 
 
 

In case of other connection 
problems please Download the 
DAVE Apps as zip file directly 
from the Infineon web and 
follow the instructions described 
there. 

Press: >Window >Preferences. 
 
 

1 2 

3 

4 
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http://www.infineon.com/cms/en/product/promopages/aim-mc/DAVE_3_Support_Portal/DAVE_Apps_download.html
http://www.infineon.com/cms/en/product/promopages/aim-mc/DAVE_3_Support_Portal/DAVE_Apps_download.html


Updates of the DAVE App Library 

 Infineon is continuously releasing new DAVE Apps 
or updating existing DAVE Apps (new device 
support or bug fixing). 

 The policy for updates of DAVE Apps is to keep 
full upward compatibility to earlier versions. 

 To update to the latest DAVE App library press 
“Check for DAVE App Updates” in Help menu. 

 This will only install updates of already 
installed DAVE Apps libraries and Device 
descriptions. To ensure  you don’t miss new 
library you may use the install library feature 
as described two pages before and check the  
filter (4a). 

 Information about the latest DAVE Apps libraries 
and Device descriptions,  release notes, etc  can 
be found on the  DAVE™ Online Support portal. 

 When updating an existing DAVE App the existing 
DAVE App version in the local  library will be kept 
and can further on used (see page 16). 
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Downloading of  DAVE™ Example Projects 
that use DAVE Apps 

Press: ->Help ->Install App Library. 
 
Select: DAVE Project Library 
Manager. 
 
Click here in case there is not such 
an entry and  activate the links. 
 
Select the Project 
PWMSP001_CNT001_Example1. 
 
Press Next. 
 
Follow the further instructions. 
 
 
 
In case of connection fails or no 
projects  are shown, please refer to 
page 11 and follow the steps 
described there. 
 
 
 
This is the example project oft 
this tutorial.  You may download 
it for your reference 
In the meantime a newer 
version is available. 
 

1 

1 

2 

2 

3 

3 

4 

4 
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Creating a new Project; To work with DAVE™ 
Apps a DAVE CE Project Type is required 

Create a new DAVE project as described on page 5 
But select the DAVE CE Project type. 
 
You may choose a different project name than here  
if you have downloaded the  reference project with 
the same name as described on the previous page. 
 
 1 

2 

1 

2 

After the project has been created: 
The Eclipse perspective is changed 
to the DAVE CE perspective 
The App Selection view  shows the 
DAVE Apps that have been 
downloaded before 
The project is visible in the 
workspace as Active Project and 
includes a Main.c 
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Selecting the Required DAVE Apps 

For the project functionality described on page two, we essentially need a PWM App 
a Count App and Interrupt (NVIC) Apps. 
 
 

1 

Double click:PWMSP001. 
 
Double click: CNT001. 
 
Select for the requested CCU4GLOBAL: Existing Apps. 
 
Press: OK. 
 
Double click: NVIC002 and then repeat this double click 
again,  to add two instances of the NVIC002 App into the 
project. 
 
 

2 

1 

2 

3 

4 

3 

5 

4 

5 

In the App Selection view the 
required DAVE Apps can be found in 
a category tree. 
 
The DAVE Apps can also be listed as 
alphabetical flat list. 
 
Key words can be used as search 
filter. 
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Old Versions of DAVE Apps 

Older versions of DAVE Apps might be used if the existing project uses already an older 

version.  It is not possible to add two different versions of the same App in one project. 

 
 

When the option “Show Latest Version 

Only” is checked only the latest installed 

version of DAVE Apps are shown. 

 
 

If not checked all installed DAVE Apps versions are shown. 
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S/W App Connectivity View and  
App Dependency TreeView 

All the DAVE™ Apps we have added to the project (double click) are visible in the S/W App 
Connectivity View and App Dependency TreeView, in addition all DAVE™ Apps are shown 
that are required by the DAVE Apps we have added. 
 
 

Click here: then this 
view will be refreshed 
 

These are the DAVE™ Apps that are automatically added 
because they are required by the DAVE™ Apps we have added 
(S/W connected) 
• CLK001: Provides clock information  
• CCU4Global: provides some global settings of the CCU4 
• RESET001: provides the API to reset peripheral modules 
 

This is the DAVE™App name 
 This is the instance 
 

When Selecting a DAVE™ 
App in the TreeView only this 
DAVE™ App plus the next 
level of required DAVE™ 
Apps will be shown in the 
S/W Connectivity. 
 

Right mouse 
click on any 
DAVE™ App 
provides  
various options 
 

We will see later the 
purpose of the  H/W 
Connectivity View 
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Deleting / Removing  of DAVE™ Apps 

If a DAVE™ App is not required any more or it has been added to the project erroneously  
or  if it should be replaced, it is possible to remove a DAVE™ App from the project. 

Right mouse click on the 
DAVE™ App that should be 
deleted. 
 
Select: Remove. 
 
Chose option, the default 
option is the safest.  
 
Press: OK, to confirm option. 
 
Press: OK, to confirm the 
deletion of the listed DAVE 
Apps. 
 
 
 
 
 
 

1 

2 

3 

4 

Note, it is not required to exercise the DAVE™ App 
remove  function for successfully accomplishing this 
tutorial. 
 
 
 
 

1 
2 

3 
4 

In this case no other DAVE™ App will be deleted because the NVIC002/0 App is not S/W dependent on 
any other DAVE App. If PWMSP001/0 would be removed also only this App will removed because 
CCU4Global, CLK001 and RESET are still required by the CNT001 App. But if then CNT001/0 APP would 
be removed, all required DAVE Apps would also be removed. 
Just give it a try and see what happens. 
 
 
 
 
 

5 

5 
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Help Information about DAVE™ Apps 

1 

2 

Select: >Help >Help Contents 
To open the help content that contains among other topics 
also a chapter for DAVE™ Apps. 
For Each DAVE™ App  there is a dedicated documentation, 
that includes all information to uses the  DAVE App 
properly. 
 
 
The DAVE™ App specific document can also be opened in 
the DAVE CE perspective when pressing F1 and  
then select the respective DAVE™ App and  
then press “Related Topics” and “More Info” in the  Help 
view. 
 
 

3 

3 

4 

4 

Content 
structure of 
each DAVE™ 
App 
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Configuration of the PWMSP001 App 

The User Interface to configure the PWMSP001 App can be opened by double click 
on the App or via right mouse option of the App: UIEditor 
 
 

1 

2 

3 

We will make the following changes to the 
default settings: 

Change PWM resolution to about 10 
µsec. 
Change PWM frequency to 100 Hz. 
Enable Period Match Interrupt. 

 

1 

2 
3 

We could also check “Start during 
initialization” to start the PWM signal 
immediately after initialization, but we 
will do it rather with the API in our 
program. 
 

Behind these taps there are other initialization 
options. For our example we can use the default 
settings, but you might check out which other 
options are provided by this DAVE App. 
 

e.g. select Passive Level as “Active High” 
because the LED is connected to 3.3V. 
 

4 

4 
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Configuration of the Count App and Clock App 

1 

2 
Double click on CNT001 App. 
 

1 

The UI of the CLK001 App allows various clock 
initializations, we keep the default value: 
 External oscillator is 12 MHz (CPU board) 
 System clock is 120 MHz 
 CCU4 clock is same as system clock 
 

2 

Count match event is set to 400. 
 
Interrupt event signal  for count 
match is enabled . 
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Adding User Labels to the DAVE™ Apps 

One of the DAVE™ App right mouse click options is to add a user label to the DAVE 
App. This feature helps to identify the right DAVE™ App and right instance  in case 
of  configuration, signal connection and manual pin assignment. 
 
We will add user labels to the NVIC Apps 
 
 1 

2 

3 

4 

5 

6 

7 

8 

1 

5 
Right mouse 
click. 
 

! 
 

! 
 

! Watch the instance 
number. 

 

The assigned user labels are now visible in the various App views. 
 
The user labels are not used in the user SW. 
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Configuration of the NVIC Apps 

1 

2 

4 

Double click on NVIC002, PWM_Period App 
 

Double click on NVIC002, CountMatch App 
 

Set the priority of the PWM period match to 
a higher priority (62). 
(lower number = higher priority) 
 
The function name for the interrupt handler 
has to be added. 
This name has to be used to define the 
interrupt function in Main.c. 
 

3 

5 

1 

3 5 

1 
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Signal Connection: Period Match to 
Interrupt 

 One of the advanced features of DAVE™ 3 is the option for the user to connect 
HW*) signals between different DAVE™ Apps 

 Animportant use case for this feature is the connection of an event signal with the 
interrupt signal of an NVIC (interrupt) App 

 When doing the signal connection the direction of the signal has to be considered 
 
 Connection of the period match event signal of the 

PWMSP001 App with the interrupt signal of an NVIC002 App 
 

Right mouse click on the DAVE™ App 
that provides the source signal. 
 
Select: Signal Connection. 
 
Select the Period Match Interrupt signal. 
 
Select the DAVE™ App that provides the 
destination signal (benefit of user label). 
 
Select: Interrupt Node. 
 
Click: Solve And Save 
then the resource solver starts. 
 
Click: Close, after the resource solver is 
finished. 
 
 
 

1 

2 

3 

4 

5 

6 

7 

1 
2 

3 4 5 

6 7 

! 
 

! 
 

*) before resource solving the HW signals are logical signals, 
after solving it is assigned to a real HW signal. 
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Signal Connection: Count Event Match to 
Interrupt 

The Event Count Match signal of the  CNT001 App has to be connected to another instance of the  
NVIC002 App (the instance  with the user label “CountMatch”). 
 
The procedure is similar as outlined on the previous page before: 
 

Right mouse click on the DAVE™ App 
that provides the source signal. 
 
Select: Signal Connection. 
 
Select the Count Match Interrupt signal. 
 
Select the DAVE™ App that provides the 
destination signal (user label 
CountMatch). 
 
Select the NVIC Interrupt. 
 
Click: Solve And Save 
then the resource solver starts. 
 
Click: Close, after the resource solver is 
finished. 
 
 
 

1 

2 

3 

4 

5 

6 

7 

1 

2 

3 4 5 

6 7 
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Signal Connection: PWM Status Signal as 
input for the Count App 

The PWM status signal of the PWMSP001 App has to be connected to the input signal of the CNT001 
App. 
 
The procedure is similar as outlined on the previous page before: 
 

Right mouse click on the DAVE™ App 
that provides the source signal. 
 
Select: Signal Connection. 
 
Select the PWM Status signal. 
 
Select the DAVE™ App that provides the 
destination signal (CNT001/0). 
 
Select the Input signal. 
 
Click: Solve And Save 
then the resource solver starts. 
 
Click: Close, after the resource solver is 
finished. 
 
 
 

1 

2 

3 

4 

5 

6 

7 

1 
2 

3 4 5 

6 7 
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H/W Connectivity View 

In addition to the S/W App Connectivity View and App Dependency TreeView shown in page 
17 there is another graphical view for DAVE Apps called H/W Connectivity View. 
The H/W connectivity view shows the connection of signals / events between DAVE Apps. 
 
 

Activation of the H/W 
Connectivity View 
 

Connectivity of the 
clock signal created 
by the App developer 
 

PWM  status signal 
 

Compare match event 
 

Count match event 
 

The other connections 
are created by us 
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Manual Pin Assignment 1 

 The resource solver integrated into DAVE™  assigns resources 
that are required by the DAVE™ Apps to the available chip 
resources 

 The resources solver ensures that the resources assignments are 
conflict free and all connectivity requirements are fulfilled 

 In particular for pad / pin assignments it is often required that 
specific constraints  of the HW PCB design are also considered 

 With the manual pin assignment functionality in DAVE™ such  
pin constraints for the resource solver can be defined 
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Manual Pin Assignment 2 

 For each DAVE App that requires a pad / pin resource the manual pin assignment 
functionality is provided (e.g. right mouse click of the App) 

 In our cases the PWMSP001 App requires  the pad /pin resource to output the PWM 
signal 

 Alternatively, if certain flexibility is required the  pad / pin requirement can be disabled in 
the  configuration UI of the PWMSP001 App (Pin Configuration tab) and the PWM Output 
signal can be connected to an IO002 App 

 
 

3 4 

5 6 

Right mouse click on the PWM App or 
any App the requires a pad/pin resource. 
 
Select: Manual Pin Assignment. 
 
Select a pin resource. 
 
Select the port / pin where this pin 
resources should be assigned to *). 
 
Click: Save. 
 
Click: Close. 
 
 
 

1 

2 

3 

4 

5 

6 

1 

2 

*) select a pin  that is connected to LED. 
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Resource Solving and Code Generation 

 The resource solver is a very innovative feature of DAVE™  
 The resources solved ensures that the resources groups required by the DAVE™ 

Apps, including the signal connections and the pin constraints  are assigned to the 
available peripherals and system resources of the XMC4500. 

 
In complex solutions it might be possible that the resources requirements can not be 
solved. To understand when this point is reached it is recommended to periodically 
run the resource solver when making resource relevant changes in the project 
(adding DAVE™ Apps, connecting signals and defining pin constraints). 
 
 
 

After finishing the work with DAVE™ Apps the libray code that provides the 
initialization routines and the API to control the functionalities of the DAVE™ Apps 
has to be generated. 
 
 
 

Press the “Solver” button the run the 
resource solver. 
 
 
 

1 

2 Press the “Generate Code” button to run the code 
generation. 
 
To ensure that code generation is always based on a 
successful solver run, a solver run will be automatically 
issued each time before code generation is started. 
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The Generated Library Code 

The generated library code is added to the project in the project folder: 
“Dave\Generated” 
The include files are located under Dave\Generated\inc 
The c source files are located under Dave\Generated\src 
 
Each  DAVE App has its own sub folder in the  “inc” and the “src” folders 
(also hidden DAVE Apps are shown here). 
 
DAVESupprt App is one of the hidden Apps that is included in each 
project, this DAVE App provides a consolidated header file (DAVE3.h) 
and specific top level initialization code. 
 
Usually there are two header files for each DAVE™ App: 
<appname>_Conf.h : contains the  declaration of the global handle 
for the different DAVE™ App instances. 
<appname>.h : contains  the DAVE™ App instance independent 
declaration of global variables and the API and it contains macros. 
 
 
Usually there are two source files for each DAVE™ App: 
<appname>_Conf.c: contains the data structure (handle) for each 
DAVE™ App instance. 
<appname>.c: contains the library functions (API.) 
 
 
Object Orientation:  
Code is independent of number of instances per DAVE™ App. 
 
XML  that contains information of the generated code that can be used 
by third party tools. 
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Using the API from the DAVE™ Apps to 
implement the required SW functionality 

1 

1 Double click to open 
Main.c in the editor area. 
 
 
 
DAVE3.h contains all *.h 
files for the used DAVE™ 
Apps. 
 
The local variable status 
can be used as return 
variable for the DAVE™ 
Apps APIs to indicate 
whether the function has 
been executed successful. 
 
DAVE_Init contains all 
initialization functions of 
the used DAVE™ Apps . 
 
 
 

The Main.c that has been created by selecting the DAVE CE project type upon new project 

creation contains already includes and init functions to uses the API of the used DAVE™ Apps. 
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Adding User Code in Main.c:  Global 
variables 

This first part of Main .c shows all global variable definitions used in this project. 

Type unit32-t is declared in  stdint.h. 

 

PWMSP001_TimerRegsType is declared in 

PWMSP001.h. 

 

With  the right mouse option “Open Declaration” the 

respective header file can be automatically opened. 
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Adding User Code in Main.c:    
Function main 

We have to start the PWM and count App because we didn’t check the  option “start after 

initialization” in the UI to configure the DAVE App. The first parameter of the function is in most of the 

cases the pointer to the data structure instance of the used DAVE App instance. 

 

Checking the return variable of the DAVE Apps API is just for demo purposes  it has no impact in the 

program flow, The same is the case of the instructions in the while(1) loop. 

 

The API  definition and syntax can be found in the help document of each DAVE™ App, 

before adding your own code, please check page 37: code completion. 

1 

1 

2 

2 

3 

3 

The function main in Main.c 
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Adding User Code in Main.c:   Interrupt 
Handlers for PWM  Timer Period Match 

Here we have to  define a function with the same  

name as defined in the configuration UI of the 

NVIC002/0 App. 

Logic to change the brightness. 
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Adding User Code in Main.c:   Interrupt 
Handlers for Count Event Match 

Here we have to  define a function with the same  

name as defined in the configuration UI of the 

NVIC002/1 App. 

Logic to change direction of the brightness change. 
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Code Completion Feature in the Eclipse Editor to 
support using the APIs of the DAVE™ Apps  correctly 

Type in the first letters of the  DAVE™ App 
from which an API should be used (all API start 
with the name of the respective DAVE™ App). 
 
Press Ctrl plus Space, then a window with all 
options to complete this instruction shows up. 
 
Select the required API (function) and  press 
return,  
then the function name will be completed and 
the required parameter types will be shown. 
 
Type the first letter of the DAVE™ App name 
after the address operator(&). 
 
Press Ctrl plus Space, then a window with all 
options to complete the first parameter shows 
up. 
 
Select the appropriate parameter and press 
return, 
then the first parameter is completed. 
 
 

1 

2 

3 

4 

5 

6 

7 

1 

2 3 

4 

5 

6 

7 

Page 37 2014-03-18 Copyright © Infineon Technologies AG 2014. All rights reserved. 



Building,… 

The complete DAVE project can also be Downloaded as zip file .  

Uses the keyword “Tutorial” to select this projects from the list of all available 

example projects. 

 

Instructions to import the downloaded zip file to your workspace: 

-> File  ->Import  ->Infineon  ->DAVE Project   ->Next 

Then check “Select Archive File” and  browse to the downloaded zip file. 

 

To test this project on the real HW the following steps  have to  be performed: 

 Building the project (page 7) 

 Downloading and debugging the project (page 8) 

The debugger allows to watch the different variables and assessing the 

functionality of this small project 

 

Please note, that the optimization settings in the projects are set to –O0 (no 

optimization) therefore the code sizes is fairly large. To create productive code we 

recommend –O2 or –Os and to check the option to remove unused sections in the 

linker settings. 

 

In case you need technical support please check out the DAVE Forum. 
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